
Help Contents

How to find what you're looking for

How to reach Presidio Software for more help

The Menus

The Windows Player Program

The DOS Player Program

The Autodesk Animator FLI/FLC Converter Program



The Menus
The Frame Bar

The File Menu

The Frames Menu

The Clip Menu

The Draw Menu

The Modes Menu

The Brush Menu

The Color Menu

The Help Menu



The Windows Player 

ANIPLAY.EXE is a Windows player for PC Animate and 3D WorkShop animations. Although it is copyrighted by 
Presidio Software, Inc., you may distribute it freely with your animations. 

We recommend that you use the enclosed compression program, LHA by Haruyasu Yoshizaki, to compress 
ANIPLAY.EXE, your animation and .wav files into one file before distributing it to people who do not own PC 
Animate or 3D WorkShop. (LHA can be used for compressing any and all software. Please read the files 
LHA213.DOC and LHA.HLP for further information.)

Usage:

Double-click on the Player icon from Windows

A series of buttons will appear (like on a VCR) that control your animation

From left to right

Load, Rewind, Stop, Play, and Fast-Forward. The last four are self-explanatory. The first button, load will load an 
animation (.ANI) file or an animation script (.AS) file. 

To load an animation click on load, set your wildcard (extension) to .ANI and select a single animation to load. Once
loaded, click on the play button and the animation will start.

To load a series of animations you first must create an animation script (.AS) file. Each line of the script file must 
contain one or more parameters and the name of the animation with a proper DOS path. The following parameters 
are allowed:

-once Play animation through one time.
-loop [n] Loop animation n times. If no n, repeat endlessly.
-ping [n] Ping pong animation n times. If no n, repeat endlessly.
-speed [n] Adjust playback speed by n (n can be positive or negative).
-hidefirst Hide the first frame until the animation begins.
-disk Force playback from disk. This is useful when you want 

to reserve some computer memory for other programs.
-pos x,y Set the X,Y position of the Window where the animation plays.

The X,Y position represents the top left corner of the window.    
The numbers must be seperated by a single space.

-size x,y Set the width and height of the window from the top left corner. 
Again the numbers must be seperated by a single space.

-fullspeed Ignores timing information and plays the animation as fast as 
possible.

-quickload Forces a load from disk (thus the -disk parameter is not needed) 
and does not check the .ani file for validity.

-leavelast You can play animations in one of three ways. First, click on 
the load button from the player and load an 
animation (.ANI) file. Second, you can click on the load button 
from the player and load an animation script (.AS) file. Third, 
from the Windows Program Manager, you can highlight 
the player icon from windows, select Properties from the 
File Menu and enter any of the above parameters and 
an animation (.ANI) file in the command line field. 

The leavelast parameter applies to the third, when starting 
an animation from the command line, normally the 
player exits and returns to windows. Adding this option 
allows you to start an animation from the command 
line and keep the player active, thus you can rewind 



and view the animation again. 

Animation Script File example:

-once c:\anim\first.ani

-loop 3 c:\anim\second.ani

-ping 2 -speed 1 d:\samples\third.ani 

Line 1 plays the animation first.ani in the anim directory on drive C, one time.

Line 2 plays the animation second.ani in the anim directory on drive C, 3 times

Line 3 plays the animation third in the samples directory on drive D, twice in ping pong mode with a speed of 1 (the 
fastest).

Use the MS-Editor from Windows or any word processor capable of saving a file in ASCII format, to create your 
script files. Save the file with an .AS extension. To load a script file, click on load from the player, select .AS as your
wildcard (extension) and select a .AS file. The file will load, click on the play button to start the script file. The 
player will exit when done and return to Windows.



The DOS Player 

ANIMATE.EXE is a DOS player for PC Animate and 3D WorkShop animations. Although it is copyrighted by Bill
Marsh, you may distribute it freely with your animations. ANIMATE.EXE must be accompanied by 
ANIMATE.DOC when it is distributed.

ANIMATE.EXE requires the DVR drivers to be in the same directory or a sub-directory named DRIVERS. We 
recommend that you use the enclosed compression program, LHA by Haruyasu Yoshizaki, to compress 
ANIMATE.EXE, ANIMATE.DOC, the drivers, and your animation into one file before distributing it to people who 
do not own PC Animate Plus or 3D WorkShop. (LHA can be used for compressing any and all software. Please 
read the files LHA213.DOC and LHA.HLP for further information.)

Usage (At the DOS prompt):

animate [-options] [path]animation file[.ani]

If no options are given, the first frame is displayed after the animation finishes loading and ANIMATE. EXE waits 
for a keystroke before playing the animation. The options are described on the next page.

Options:

-once Play animation through one time.
-loop [n] Loop animation n times. If no n, repeat endlessly.
-ping [n] Ping pong animation n times. If no n, repeat endlessly.

-speed [n] Adjust playback speed by n (n can be positive or negative).
-hidefirst Hide the first frame until the animation begins.
-leavelast Leave last frame showing after quitting ANIMATE.EXE. This leaves the screen in graphics 

mode and may cause problems. The screen may be reset to text mode with the DOS MODE 
command.

-disk Force playback from disk. This is useful when you want to reserve some computer memory for 
other programs.

Examples:

        animate -loop 70 -leavelast myfile.ani

        animate -ping -speed 4 d:\animate\myfile

Keyboard Commands

While running, ANIMATE.EXE accepts the following keyboard commands:

Enter Hurry along to next frame, breaks out of slow Playback Speeds and Loop f/x.
right-arrow Reverse direction of animation.

left-arrow Reverse direction of animation.
Up-arrow Speed up animation.

Down-arrow Slow down animation.
0-9 Set relative speed.

^up-arrow Return animation to original speed.
^down-arrow Return animation to original speed.

F1 Run animation once (also O).
F2 Loop animation continuously (also L and Enter).
F3 Run animation in ping pong mode (also P).

Spacebar Pause animation.
Mouse Click Pause animation.

Q Quit ANIMATE.EXE.



Esc Quit ANIMATE.EXE.

While paused, ANIMATE.EXE accepts the following keyboard commands:

Left-arrow Move to previous frame.
Right-arrow Move to next frame.

Spacebar Restart paused animation.
Mouse click Restart paused animation.



The Autodesk FLI/FLC Converter

CVTFLC.EXE is the converter program for Autodesk Animator FLI files and Animator Pro FLC files. It requires 
that the DRIVERS subdirectory (with the drivers) be in the same directory with it. To convert from Autodesk to 
Presidio, run CVTFLC.EXE with the name of the FLI or FLC file as a parameter. The file extension is optional.

CVTFLC SAMPLE.FLC

The file is converted into an ANI file with the same name.

To convert from Presidio to Autodesk, run CVTFLC.EXE with a -R and the name of an ANI file as parameters. The 
file extension is optional.

CVTFLC -R SAMPLE.ANI

320x200x256 files are converted into FLIs. Others into FLCs.



 How to find what you're looking for...

This help file is organized like the refrence section of your PC Animate for Windows Manual. 
This on-line help is for refrence only. Make sure you play with the tutorial in the manual to 
get a better feel for the program. 

To locate a Menu select The Menus from the Contents screen and select a menu.    To locate a
Menu Item click on the Search Button and type the name of the menu (or any other topic). 
Click on find to list all topics that match the word you entered. Select one and click on Go To 
to see that topic.



How to reach Presidio Software for more help...

You can write to us at:
Presidio Software, Inc.
Attn. Technical    Support
2215 Chestnut Street
San Francisco, CA 94123

You can call technical support at 415.441.2466

You can converse with us on Compuserve. Type    GO PRES at any ! prompt.



The Frame Bar

An animation, like a film, consists of a series of frames. When the frames are played rapidly 
in sequence, the illusion of motion is created.    So, when youre building an animation, youre 
working in a file that contains a collection of up to 999 frames    each with its own color, 
sound, and speed characteristics.    This could get complicated. Keeping it simple is what the 
Frame Bar is all about.
The Frame Bar contains all the tools you need to move forward and backward in your 
animation; select a limited sequence of frames to apply a certain effect to; and actually play 
the animation.    It also tells you important information about whats going in the frame thats 
currently onscreen.

Viewing the Frame Bar
You dont have to have the Frame Bar onscreen unless you want to use it.    To bring it 
onscreen, just go to the Frame menu on the menu bar at the top of the screen. Select Frame 
Bar    the first command on the Frame menu    and the bar appears at the bottom of the 
screen.    You can grab the top of the Frame Bar with the cursor arrow, and drag it anywhere 
onscreen you want it.

Putting the Frame Bar Away
To make the Frame Bar disappear, select the Frame Bar command again    or just click in the 
small box at the far upper left of    the Frame Bar window to close it.

Words vs. Icons
You can choose to have the Frame Bar commands displayed onscreen as icons, or as words. 
Select Preferences from the File Menu to change the buttons on the top row of the Frame Bar
from text to icons.    Click Use Text or Use Icons to indicate your preference. Both version of 
each button are shown below.
Heres what youll find on the Frame Bar, reading from top to bottom, right to left:

First
Click this button to return instantly to the first frame of your animation.

Rewind
Plays the animation backward once, starting at the frame    thats currently onscreen, and 
ending with the first frame.

Back
Plays the entire animation backward once,    starting with the last frame of the animation, 
and ending with the first frame.    You can use the F/S/A settings (described below) to define 
a smaller segment of the animation to be played.

Insert
Duplicates the current frame, and inserts the copy in the frame just    before it.    For 
example, if you had five frames in your animation, and frame 5 was currently onscreen in 
the workspace,    Insert would:
 Make a copy of the current frame (frame 5), and 
 Insert the copy as a new frame just before it in the sequence (between frames 4 and 5).
Your animation would now be six frames long, with the same artwork appearing in both 
frames 5 (the duplicate) and 6 (the new current frame).

Previous
Click this to move to the frame just before the current one.    For example, if frame 5 was the 
current frame,    clicking Previous would move you back one frame.    Frame 4 would now 
appear in the workspace screen.



Next
Click this to view the next frame in the sequence.    In other words, the current frame would 
change from frame 5 to frame 6.

Insert A Frame
Duplicates the current frame, and inserts the copy in the frame just    after it.    For example, 
if you had seven frames in your animation, and frame 5 was currently onscreen in the 
workspace,    Insert would:
 Make a copy of the current frame (frame 5), and 
 Insert the copy as a new frame just after it in the sequence (between frames 5 and 6).
Your animation would now be eight frames long, with the same artwork appearing in both 
frames 5 (the original) and 6 (the duplicate).

Play
To run the entire animation from the beginning, set the F/S/A button (in the second row of    
the Frame Bar, and discussed below) to A, and then click this.    
If you want to run just a portion of the animation, set the F/S/A button to S, and define the 
segment according to the instructions below. Then select Play to run the segment.

Forward
Plays the entire animation forward one time, starting with the current frame and running 
until the end. 

End
Takes you directly to the last frame of the animation.

Frame Count
This button tells you how many frames youve currently got in your animation. 
It does another trick, too: Click on it once to copy the final frame in the animation 10 times, 
and add those 10 new frames to the end of your existing animation.    This is a quick way of   
setting up new frames as your animation progresses.
If you want remove the added frames, set    the F/S/A bar to S and use the Segment Range 
Selector Bar (discussed below) to select the segment of frames you want deleted.    Select 
Delete from the Frame Menu, and click OK from the dialogue box that appears.

Flip Five
Flip Five plays just eleven frames of animation    the five before the current frame,    your 
current frame, and then the five after.    This gives you a quick idea of how the well the 
animation and artwork in the current frame fit into the overall production.

Once/Loop/Ping Pong
This three-way toggle button lets you choose to play your animation in one of three ways:
 Once    Plays the animation through one time only.
 Loop    Loops the animation continuously, repeating the play back from the beginning each 
time.
 Ping Pong    Similar to Loop, but the playback repeats from the beginning to the end, then 
runs backward from the end to the beginning, and then goes forward again.
You can use the F/S/A settings discussed below to loop the entire animation, or just a section
of it.    
To end the playback of a looped or ping-pong sequence, click the right mouse button.    

Playback Speed
The Playback Speed button is a shortcut to the Playback Speed window.    (The other way to 
view this window is to go up to the menu bar, and select Playback Speed from the Frames 



menu.)
From the Playback Speed window, you can set the speed at which your animation is played 
back.    A complete discussion of this window is found on page 58.
The number that appears on the Playback Speed button in the Frame Bar shows the current 
playback speed of the frame, expressed on a scale of 1 (slowest) to 100 (fastest).

Sequence Range Selector Bar
Many times, youll want to perform an operation on some    but    not all    of the frames in your
animation.    This selector bar lets you define a limited range of frames to play back, work on,
or apply a certain effect to.    Its one of the most 
powerful tools in PC Animate for Windows: if you want to do the same thing to several 
frames,    you dont have do it over and over in each individual frame. Instead, you can select 
all the frames, set up the operation once, and let the computer do the repetitive part for 
you.
The Range Selector Bar is a long bar containing a    spool-shaped icon and a diamond-shaped
icon. The two icons are connected with a line.    You can grab either icon with the cursor, and 
drag it    to the left or right along the bar.    

The spool represents your starting place in the animation, and the diamond represents your 
ending place.    They work much like a scroll bar:    the entire length of the bar represents the 
full length of your animation, and the relative positions of the spool and the diamond 
indicate specific locations within the animation file.      

For example, in a 30-frame animation,    if you placed the spool about a third of the way from
the left, and the diamond about a third of the way from the right,    youd be selecting a 
segment of frames that started around frame 10, and ended at about frame 20.    
Note that you can also define frames in reverse.    In the above example, if you reversed the 
positions of the spool and the diamond, whatever effect you applied to the    segment would 
begin in frame 20, and work backwards to frame 10.    This is useful , because it allows you 
to create certain effects that would be impossible to program in forward motion.    For 
example, of you wanted to make the pieces of a jigsaw puzzle fly together on the screen, it 
would be easier to start with the completed puzzle in frame 20, and then have the pieces fly 
apart to frame 10. When you play the animation forward from frame 10 to frame 20, the 
pieces will look like theyre flying together.
 Two number indicators    The spool and diamond let you zero in on a specific piece of your 
animation; the number buttons to the right and left of the range selector bar let you pinpoint
a specific frame precisely.    
The number on the left of the selector bar corresponds to the position of the spool.    The 
number on the right corresponds to the diamond.    To change the numbers in these boxes, 
you can either;
1. Fidget with the spool and diamond until the numbers indicate youve got the frames you 
want;
2. Click the right and left arrows on either side of each number to increment up or down, one
frame at a time;
3. Click directly in one of the number boxes, and type the number of the frame youre aiming 
for.

Frame/Segment/All
This three-way toggle is one of the most-used and versatile commands in the entire 
program. (Thats why its the only button on the Frame Bar that appears in a bright color.) It    
allows you to indicate whether you want a certain command or effect applied to a single 
frame of animation, a selected segment of frames, or 
 Frame    Toggle to F to apply the command or effect to the current frame only.
 Segment    Toggle to S to apply the command or effect to the segment of frames indicated 
by the range selector bar (located to the immediate left, and explained above.)    If you insert



new frames into the sequence at a later time, the effect will not be applied to the new 
frames.
 All    Toggle to A to apply the command or effect to every frame of the animation. If you add 
new frames to the end of the sequence later, the effect will not be applied to the new 
frames.

Tween
Tweening is a    feature that allows you to automatically create a certain incremental change 
over a given range of frames.    Click this button to toggle Tween off or on.
An example of tweening may be helpful here.    Imagine that    you wanted your screen to 
gradually fade to black over a sequence of 15 frames.    Using Tween with the Fade command
(located under Color F/X on the Color menu) and the range selector bar, you could select the
range of 15 frames, and indicate only the color settings you wanted in the first frame (full 
light) and the last frame (total blackness).      The Tween command would take it from there, 
incrementally darkening the color settings by 1/15th with each successive frame.    When the
final animation played, the result would be an even, consistent fade to black.
Tween works with a great many of the frame, sound, and color effects youll find in PC 
Animate for    Windows.    To find out if it applies to the effect you want to use,    turn to the 
description of that effect in the menu sections.

Undo
Undo reversed the last change you made to the current frame. 
Once you make an additional change to a frame, leave the frame, or do a multi-frame 
change with Segment or All, you can no longer undo the previous change.
However, Undo can be reversed: if you selected Undo to erase a change, you can 
immediately choose Undo again to restore it.

Loop F/x
Click this to gain instant access to the Loop F/X dialogue box. (This is the shortcut: the long 
way is to select Loop F/X from the Frame menu.) To find out    more about whats in the Loop 
F/X box, see    the Frame Menu.

Sound F/x
Click this to gain instant access to the Sound F/X dialogue box. (The longer way is to select 
Sound F/X from the Sound menu.)    To find out more about how to use Sound F/X, see the 
Frame Menu.

Volume Setting
Click this to gain instant access to the Volume F/X dialogue box.    (The longer way is to 
select Volume F/X from the Sound menu.)      To find out more about how to use the Volume 
F/X command, see the Frame Menu.
The number in the middle of the button indicates the present volume setting for the current 
frame.

Sound Balance
Like the Volume F/X button just described, the Sound Balance button provides a shortcut to 
the Volume F/X dialogue box.    The numbers in the center of this button indicate the 
percentage of the overall sound thats coming from each of the two stereo channels.    These 
settings can be changed from inside the Volume F/X box. 
To find out how to change the sound balance, please turn to the Frame Menu.

Over/Under
This command lets you apply the incoming artwork (that is, the artwork thats stored in the 
Clip buffer) over or under the existing artwork in the workspace screen.    Use the onscreen 
bounding box to position the incoming art where you want it.    



If you select Over, the new art element will be pasted on top of the current artwork on the 
screen.    If you select Under, wherever the    onscreen artwork overlaps your art element, it 
will pasted over, with your new graphic peeking out from underneath.
If you dont like what youve done, you can undo it by immediately choosing Undo from the 
Draw menu or Frame Bar.

Use All/No Keys/No Pic
Use All/No Keys/No Pic lets you indicate the overlay/underlay relationship between the 
incoming and existing artwork.
Use All    The top image completely covers the image behind it. If the incoming clip is smaller
than the full frame, it only covers a portion of the background screen.
No Keys    The Key Color is usually your background color. When you open a new file, the 
default Key color is black.      (To set a new keycolor, choose Select Key Color from the Color 
menu.)    The No Keys command removes all traces of the key color that may appear in the 
top image, so that the image underneath can show through.
No Pic    The No Picture command cuts a stencil-like window in the background color, so that 
any images placed behind the background can show through.    The cutout eliminates all 
picture areas (those that appear in colors other than the key color) of the top image.
Here are the effects you can achieve by combining Use All/No Keys/No Pic in combination 
with the Over/Under settings described above:
 Over/Use All:      Pastes the entire clip over the existing artwork
 Over/No Keys:    Eliminates the key color areas from the clip, and pastes the clip over the 
existing artwork.    The existing art shows through the areas of the clip that used to be in the 
key color.
 Under/No Keys:    Removes the key color from the existing artwork, and pastes the clip 
underneath . The clip shows through in the areas where the key color used to be. 
 Over/No Pic:      Removes the colored picture areas from the clip, creating a stencil-like 
outline cut in the key color background. This stencil    is placed over the existing artwork, 
which only appears through the holes in the stencil.
 Under/No Pic:    Removes the colored picture areas from the existing frame, creating a 
stencil-like outline cut in the key color background.    The clip is then pasted underneath this 
stencil, and appears only through the stencils holes.
 Under/Use All.    This isnt a valid command, because it would paste the clip under the 
existing frames creating no change at all.
You may not gain a full understanding of the potential of these commands until you spend 
some time working with them.    They are covered in Chapter 5 of the tutorial secton of your 
manual.

Restore
Restore erases all changes made to the current frame since you entered it.    Restore can be 
reversed with Undo    though this must be done before any additional changes are made.    
Once you leave a frame or do a multi-frame change, the contents of the frame can no longer
be restored. 



The File Menu

Prefrences
This dialogue box lets you customize some of the features in PC Animate for Windows to suit 
your own preferences.

Non-Zoomed Window 
This preference applies only    your Windows frame is smaller than PC Animates workspace 
screen    for example, when you shrink the PC Animate window to make room for another 
program window on the screen.    
While the screen is shrunk, you can choose    Dont Clip to apply your PC Animate commands 
to the entire workspace frame; or    Clip to Window to apply the command just to the parts 
that are visible in the small window.

Start-up Warnings
Whenever you launch PC Animate for Windows, a series of onscreen warnings appears to 
give you information about the status of your computers memory, video capabilities, and 
other program variables.    Click Show to view these warnings with each start-up, or Dont 
Show to turn them off in future program launches.

Window Positions
There are four windows    Frame Bar, Select Color, Select Key, and Select Brush    that stay on
screen at all times unless you click in the upper left corner to close them. When you choose 
Save from this menu, the last positions of these windows are saved with your file, so theyll 
appear in the same places when you re-enter that file.    If you choose Dont Save, youll    
need to manually reopen and place these four windows each time you re-enter the file.
This preference works in concert    with    Auto Start, explained below.    

Frame Bar
Use this preference setting to indicate whether you want the top row of Frame Bar 
commands to labeled with text, or with icons.

Auto Start
You can ask to have the Frame Bar, Select Color palette, Select Key Color palette, and Select 
Brush menu appear onscreen automatically when you open a file.    Just click the boxes to 
indicate which of these four dialogue boxes you want opened for you.

Zoom Factor
This slider lets you indicate how far you want to zoom in on something with each click of the 
Zoom tool.    Set the slider from 2x magnification to 16x magnification.    The default setting 
is 8x.

Video Mode 
PC Animate for Windows fully supports VGA and the VESA standard for SuperVGA. Many 
SuperVGA graphics boards do not directly support the VESA standard; you must run a 
program (sometimes called a TSR) to make these boards compatible. The program is usually
on the disks of software which come with the boards. If your board is not VESA-compatible 
and you did not receive a VESA program, contact the board manufacturer. 
PC Animate for Windows also supports 32,767 colors on graphics boards utilizing the Tseng 
4000 chipset and Sierra RAMDAC. 
The Video Mode dialogue box displays the following options:
640x350x16 (EGA) 
1024x768x256 (VESA)
320x200x256 (VGA)
1280x1024x16 (VESA)



640x400x16 (VGA)
1280x1024x256 (VESA)
640x480x16 (VGA)
320x200x32K (Tseng/Sierra)
640x400x256 (VESA)
640x400x32K (Tseng/Sierra)
640x480x256 (VESA)
640x480x32K (Tseng/Sierra)
800x600x16 (VESA)
800x600x32K (Tseng/Sierra)
800x600x256 (VESA)
1024x768x32K (Tseng/Sierra)
1024x768x16 (VESA)
1280x1024x32K (Tseng/Sierra)

Use the scroll bar to view all the resolution/color combinations. Click OK to select the new 
one, or Cancel to leave the directory without choosing any of them. 
Resolution/color combinations which are not available with your hardware are grayed out.

New Anim
Press this to delete the current animation on the screen. A Confirm box appears to ask if this 
is really what you want to do. 

    OK deletes the current animation from the main workspace, freeing you to load a new one.
If you do this, none of the changes you have made to the animation since loading it will be 
saved.

 Cancel exits the Confirm box, and leaves the animation as is. From here, you may want to 
choose Save from the File menu to save the current animation.

Open
PC Animate for Windows lets you combine a wide variety of resource files    backgrounds, 
objects, sound files, animation movement sequences, and so on    into your productions.    
The Open dialogue box lets you load every type of file PC Animate for Windows uses into the
workspace screen, the Frame F/X buffer, or the Clip buffer. When you click Open, the Load 
Picture/Animation dialogue box appears. Heres whats in it:

Format Type 
PC Animate for Windows can load images in five file formats: 

 ANI    The standard PC Animate for Windows animation file format. It contains all the 
information for an animation. ANI files can only be loaded into the same video mode in 
which they were created. PC Animate for Windows comes with a separate program to 
convert ANI files to and from the Autodesk Animator FLI and FLC formats (see Online Help). 
FLI format does not support sound.

 GIF    A single-picture format established by CompuServe Information Service.

 PCX    A single-picture format established by PC Paintbrush, a popular paint program 
published by Zsoft.

 TIFF    (Tagged Image File Format) A single-picture format established by Aldus Corporation 
and Microsoft Corporation. PC Animate for Windows supports both compressed and 
uncompressed TIFF files.



 BMP (Bitmap) A single-picture format established by Microsoft.

Destination
You can open your new file in one of three areas: 

    Anim    adds the new file to the current workspace area. A single picture is loaded as if it 
were a one-frame animation. 

    Clip    loads the new file in the clip buffer, which holds cut and paste items. When an ANI 
file is loaded into the clip buffer, only the first frame is used. Files can be loaded into clip 
using Paste (in which case the incoming frame is overlaid or underlaid on the existing clip), 
or using Replace (in which case the existing clip is erased and replaced by the incoming 
frame.)

    Frame F/X      adds the new file to the Frame F/X module. Generally, youll do this when you 
want to apply additional    frame effects to an existing animation in the Frame F/X buffer. A 
single picture is loaded as if it were a one-frame animation. 

When you choose Frame F/X, you must also select the Replace option from the Operation 
box to the right. This erases any existing file in the Frame F/X buffer and replaces it with the 
incoming file. 

Operation
These options offer you three ways to load the new file to an existing animation. (If youre 
loading into an empty workspace, the default option is Paste.)

    Paste    Loads the new image into the existing workspace.    Use the Over/Under setting in 
the Frame Bar to indicate whether the new image should be pasted over or under the 
existing images. 

Paste is also the option to use if youre opening a new workspace.

    Replace    Replaces the indicated frames with the ones in the new file. Use the range 
selector bar in the Frame Bar to indicate which frames you want replaced.      The old frames 
will be gone for good, so make sure youve saved them elsewhere if you want to keep them.

    Append    Adds the new frames or images to the end of the current sequence of animations
or images.

Paste Options
Loops/No Loops    When there are fewer frames in your incoming    .FFX file than there are in 
the animation (or animation segment) youve chosen, this feature offers you two options. 

    Loops repeats the sequence of frames in the .FFX file over and over until the end of your 
selected frame range is reached. 

    No Loops loads the animation just once. If the number of incoming frames doesnt cover 
the entire frame range you selected, the leftover frames at the end of the range remain as 
they were.
Fit Colors    Click this to automatically adjust the colors in the animation youre loading so 
theyre as close as possible to those in the existing workspace.
Center    Click this to automatically center the incoming image in the middle of the screen.

Cancel 
Select this to leave the Load Picture/Animation Files dialogue box at any time, without 



executing any of the commands or changing anything in your workspaces.

Save
Save saves the current workspace to the last known file name. If its a new, unnamed file, the
Save Files dialogue box appears.    For a detailed explanation of the Save Files box, see Save 
As below.

Save As
Use this box to save newly created files, or to save the contents of an existing workspace 
under a new name.

Source 
Heres where you indicate exactly what you want to save.

    Anim saves all the elements in your main workspace.    
    Clip Buffer saves the image currently in your clip buffer.

Animation Files 
These instructions allow you to dictate how the animation will be reloaded and replayed 
when you next return to it.
Once/Loop/Ping Pong    You can choose to play back your reloaded animation one of three 
ways:
    Once    Play the animation through one time only.
    Loop    Loop animation continuously, repeating the playback from the beginning each time.
    Ping Pong    Similar to Loop, but the playback repeats from beginning to end, then runs 
backward from the end to the beginning, and then goes forward again.
To end the playback of a looped or ping-pong sequence, click the right mouse button.    
Hide First/Leave Last/Auto-Start    Use these options to indicate how you want the animation 
to be presented on the screen when you next reload.
    Hide first    hide the first frame until animation is completely loaded
    Leave last    leave the last frame onscreen when the animation is finished running
    Auto Start    start playing the animation automatically upon reloading

Memo    This is simply a short text area that you can use to make personal notes about the 
file, such as the title, description, version number, an artists name, or anything else you 
want to be sure to remember about this file. You might also use this space to pass a 
message to a custom player program, such as the name of the MIDI file that goes with the 
animation, or the name of the file that should be played next.
Whenever you load an animation using the Replace option, the memo for that animation 
appears here.

Picture Files 
Click one of these buttons to choose the format you want to use for the save.    (Note that 
you have the option to compress TIFF files as you save them.)    
Cancel 
Click this abort the Save As dialog box without saving.

Exit
This command exits PC Animate for Windows and returns you to Windows.    Before quitting, 
the program displays a warning box so you can change your mind. 
Exit erases any temporary files which PC Animate for Windows may have created during this
session. If you leave PC Animate for Windows without exiting first (by turning off or resetting 
the computer, for example) the temporary files are not deleted, and will continue to occupy 
disk space.



The Frames Menu
The Frames menu contains some of the tools youll use most frequently in manipulating the 
animations you create.    There are three basic sets of commands:
    Commands that let you direct how the animations are replayed
    Frame, sound, and other special effects
    Cel animation tools that help you quickly duplicate and position artwork across a series of 
frames. 

Frame Bar 
Makes the Frame Bar appear and disappear.    For a full description of the Frame Bar, please 
refer to The Frame Bar .

Once
Plays the current animation through one time. Set the F/S/A button on the Frame Bar to 
Segment to replay    just part of the animation, or All to play the entire animation file.

Loop
Plays the current animation continuously, repeating over and over again from the beginning.
If    the F/S/A button on the Frame Bar is set to Segment,    just the selected range of frames 
will be played.

Ping Pong
Repeats the current animation continuously, from beginning to end and then backward from 
the end to the beginning. If the F/S/A button on the Frame Bar is set to Segment mode, just 
the selected segment is played.

Playback Speed
Choose this option to set the speed at which your animation is played back. 
PC Animate for Windows gives you the ability to assign each frame in your animation a 
different time value    that is, you can choose to replay some frames faster, and some slower,
thus creating a custom combination of fast action and long pauses during the playback.    
You might use this feature to create slideshow-like presentations, where you want still 
images that change slowly from frame to frame.      It also allows you to control the speed of 
a characters movement within a cartoon-like animation.
The Playback Time number at the left of the dialogue box represents the time value 
assigned to the current frame, expressed on a scale of 1 (a very short delay before changing
to the next frame) to 100 (a long, static pause before changing to the next frame). Larger 
numbers create slower animations, and smaller numbers create faster animations. You can 
choose how many frames you want a single Playback Time number to apply to by selecting 
from the F/S/A button on the Frame Bar.    For example, to set one individual frame at a 
playback speed of 50, you would:
1. Make sure that frame you want to set the time value for is the current frame in the 
workspace screen.
2. Choose Frame Bar from the Frames Menu, and set the F/S/A box to F.
3. Select Playback Speed from the Frames menu.
4. Set the Playback Time number to 50.
5. Click OK.
To set the playback speed for the entire animation to 50,    you would follow the exact 
procedure above, with just one change: in step 2, you would set the F/S/A toggle on the 
Frame Bar to A (All).
During playback, you can change the overall speed by:
 Pressing the down keyboard arrow to increase the time value in each frame, slowing down 
the animation.
    Pressing the up keyboard arrow to decrease the time value in each frame, speeding up the
animation. These adjustments are temporary, and dont permanently affect the playback 



speed values you might have assigned to saved animation.

Flip Five
Flip Five is a quick way to check on your progress as you develop sections of your animation.
It plays (in Ping Pong mode) an 11-frame segment that starts five frames before the current 
frame, and ends five frames after it. Flip Five ignores Loop F/X. 
Press Esc or right-click to end Flip Five.

Frame f/x
The Frame F/X    dialogue box gives you access to one of the most    versatile and powerful 
tool kits within PC Animate for Windows.    With these features, you can create and save a 
series of movement commands to direct complex motion sequences for your animations. 
These sequences are saved in their own separate files (called .FFX files) and loaded into the 
clip or frame F/X buffers to direct the motion of any animation.

File Management Commands
The six buttons in the far left column let you create, load, and save .FFX files.
Clear    Clears out all current frame F/X settings, and returns them to their default values.
Start/Motion      Toggle this to indicate whether the current settings apply to the starting 
position of the image, or the actual motion of the image.
Clip/Anim/File    This three-way toggle lets you choose which workspace you want to apply 
the selected effect to.
 Clip applies the indicated frame F/X to the image in the clip buffer.    This clip will    be pasted
into the main workspace,    following all the specified frame F/X parameters.    This is useful 
for applying a second animation to an object thats already animated    such as adding a 
revolving message over a balloon thats floating across the screen.
 Anim    lets you center, move, or turn the entire workspace screen    even while theres other 
animation running inside the screen. For example, if    you had a rotating animation of a 
running figure in one area of the screen, the figure would keep running even while you used 
Anim to rotate the entire screen. 
 File applies your frame    effect to the file loaded into the Frame F/X buffer.    This allows you 
to transfer an animation from another file into your current workspace. (Use Loops/No Loops 
to indicate how many frames the animation should be imported into.) 
Loops/No Loops    This toggle button gives you two options for applying a frame effect to an 
animation. These options apply only when there are more frames in your selected animation 
segment than there are in your incoming frame F/X sequence.
 Loops repeats the frame F/X command sequence over and over until the effect has been 
applied to all the frames in your selected segment. 
 No loops runs the frame F/X sequence only once, and leaves the remaining    animation 
frames in the selected range unchanged.
Load F/X    Click this to load an existing .FFX file into the Frame F/X buffer.    From the dialogue
box that appears, highlight the name of the file you want to load, and click OK to begin 
loading.    Press Cancel to leave the box without loading anything.
Save F/X    Saves the current frame F/X settings to an .FFX file.    Enter the new file name in 
the text box at the top left of the dialogue box, and use the other directories to indicate 
where the new file should be stored. Click OK to initiate the save, or Cancel to leave the 
dialogue box without saving.

Motion Control Buttons
The three buttons in the second column from the left let you create a path of motion for your
animation, or turn or resize it. Each of the three also has its own sub-commands, which 
appear in the box to the immediate right. These sub-commands change, depending on 
which motion control button you choose.
You can combine the Turn, Size, and Move commands, and apply them all to the same object 
simultaneously.    For example, you might have a globe spinning across the screen, growing 



bigger as it approaches on a curved path.    In this case, you would use Turn to spin the 
globe, Move to define the curved path, and Size to make it appear larger as it approaches.

Turn 
Turns the selected image on an X, Y, or pseudo- Z axis.    The two buttons in the box on the 
right give you two ways to describe the kind of turn you want:
 Center    There are three ways to indicate the center point of you animation    that is, the 
point around which the turn will occur. Click Center to begin, and then choose one of the 
following:
1. Mouse XY    Click this to turn your cursor into an onscreen crosshair. Position the crosshair 
and click at the center point around which you want the turn to occur. 
2. Default    Automatically centers the turn around the center of the workspace screen.
3. By the Numbers      Use the X, Y, and Z fields in the box on the right to indicate the 
coordinates of the pixel that should occupy the center of the turn.    Move the slider bars to 
scroll the numbers up and down, or click on the number box and type the coordinates you 
want.
Turns The Partial Turn slider expresses the amount of turn in degrees.    A complete turn is 
360 degrees, so a +90 degree turn would be a one-quarter turn to the right (clockwise), and 
a - 90 degree turn would be a one-quarter turn to the left (counterclockwise). 
The Full Turns slider sets the number of full turns around the selected axis, up to a maximum
of 16 turns.    This slider works in cooperation with the Partial Turns slider: if you want three 
and a half turns, set the Full Turns slider to 3 and the Partial Turns slider to 180 degrees.
Note that your turns are not restricted to just one axis. The X,Y, and Z settings work in 
combination to create any degree or direction of turn you wish.

Size
Resizes an image. This is useful for making objects appear to move closer (by making them 
grow larger with each frame), or farther away (by making them smaller with each frame.) 
Resizing is a two-step process: you first select the center point    around which the resize will 
occur, and then indicate how big or small you want the image to become.
 Center    Click this to set the center point around which the resizing will occur.    There are 
three different    ways you might select this point:
1. Mouse XY    Click this to turn your cursor into an onscreen crosshair. Position the crosshair 
and click to select the center point. 
2. Default    Automatically centers the resize around the center of the workspace screen or 
buffer.
3. By the Numbers      Use the X, Y, and Z number fields in the box on the right to enter the 
coordinates of the pixel that should occupy the center of the resizing operation.    Move the 
slider bars to scroll the numbers up and down, or click on the number box and type the 
coordinates you want.
    Size    Click this, then use the slider bar to the right to indicate how big the resized object 
should become.    The size is expressed as a percentage of the current image size    thus, if 
you set the ratio at 100%, the size will remain unchanged. You can make the image as small 
as 1% of its current size, or blow it up until its 10,000% bigger.

Move 
This command gives you four different ways to draw the path along which you want    a clip, 
animation, or file to move:
    Line      Lets you create a straight line for the image to follow.    You set up the line by simply
indicating a starting point and an ending point, and the animation will move in a straight 
path between them. There are two ways to set the paths beginning and end:
By the numbers    Use this option when you need the precision of expressing your X, Y, and Z
axis coordinates as onscreen pixel locations.    The cursors current pixel coordinates appear 
at the top left of the screen.
1. Click the Start/Motion button at left to toggle to Start.



2. Use the slider bars at right to set the starting point of the line.
3. Click the Start/Motion button again to toggle to Motion.
4. Use the slider bars to indicate the ending point of the line of motion.
5. Click the Display button to see what the line of motion looks like.    To return to the Frame 
F/X box, click the right mouse button.
Note that you can use the X, Y, and Z axes together to describe any three-dimensional 
movement path you want.
The space described by the X and Y coordinates is about four times the size of your actual 
video screen, so you can move objects off the edges of the screen and on again.    The Z 
slider ranges from +640 (that is, 640 pixels back from the plane of the screen) to - 640 (640 
pixels in front of the plane of the screen). 
With the mouse      Instead of using the slider bars in steps 2 and 4 above, click on the 
MouseXY button to display an onscreen crosshair. Click the left mouse button on both the 
starting and ending points. 
You cant move animations on and off the edge of the screen using the mouse.    Use the 
slider bars described just above to access this extra offscreen space.
 Points    The motion path created by this option is a series of points connected by straight 
line segments.    The image will move from point to point in a connect-the-dots type of 
sequence.    To use:
1. Click Points to move into the Frame F/X workspace. 
2. Click onscreen to indicate the starting and ending points of each line segment.    You can 
use up to 200 line segments to describe the path. 
 Spline    This works just like Points, with one added trick: once the segment path is drawn, 
you can drag and pull the straight lines between the points into arcs, creating a more 
curving, fluid path.    
 Sampled    Click Sampled and move the mouse to draw a freehand motion path.
Render    Click this to activate all the Frame F/X settings youve chosen, and permanently 
apply them to the animation in the selected workspace. Its the equivalent of Go!Once you 
leave the Frame F/X box, the rendering cannot be undone. We strong recommend that you 
save your existing animation before rendering a new set of frame effects.    Theres a warning
box in case you change your mind.
To interrupt a rendering, press Esc. The rendering stops after finishing the frame it was 
working on.    When you interrupt a rendering, the frames already rendered will have the new
animation, and the remaining frames will retain their old settings.    A warning box lets you 
change your mind and continue the rendering.
Preview      Click this to view a sketched-in preview of your chosen effects sequence, without 
making a permanent change to the main workspace.
Exit    Exits the Frame F/X dialog box.
Clear    Erases all the settings in the Frame F/X dialogue box. They cannot be restored. There 
is a warning box so you can change your mind.

Sound f/x
Lets you key the beginning of a sound file to a specific frame of animation. The sound file 
will continue to play    until the sound ends, or a new sound file it launched and overrides it.
PC Animate for Windows uses Windows-compatible digitized sound files, so youll    need a 
Windows-compatible sound board in order to create sound effects. 
Sound files run to completion independently of the frames. This means that if you slow down
the animation speed, the sounds end at an earlier frame; and if you speed up the animation,
the sounds end at a later frame. 
To attach a sound file to a specific frame:
1. Click Load to load the .WAV files you want to use into the sound F/X buffer.    The loaded 
files appear in the directory box at left.    Click the file you want to load.
2. Your chosen selection appears in the Selected box at the top of the screen.
3. Click Preview to hear the sound, if you want to.
4. The number in the Play box determines the number of times the sound should be 



repeated in sequence. Click this box and type the number you want.
Clear removes the highlighted file from the Selected box without loading it.    This allows you 
choose another selection instead.
Delete removes the selected .WAV file from the Sound F/X buffer. It then disappears from the
directory at left.    This frees up memory, but to recover the sound, you must load it again.
Record executes your selection: it permanently cues the start of your chosen sound file to 
the current frame of animation in the main workspace.    Recorded sounds can be changed 
by returning to Sound F/X and reassigning them.
Cancel    exits the Sound F/X dialog box without taking any action.

Volume f/x
Once youve applied a sound effect to start at a specific frame in your animation, you can 
use this feature to change the volume of your sound effect as it plays.    For example, you 
could make a train whistle start soft and grow louder as the train image moved closer on the
screen.    Heres how to do it:

1. Go to the Frame Bar, and use the F/S/A toggle and the range selector bar to select the 
range of frames for your new sound effect.
2. Toggle the Start/End button to Start.
3. Use the Balance slider to indicate the relative right/left    sound balance between two 
stereo speakers.
4. Move the Master Volume slider if you want to change the overall volume for both 
speakers.
5. Click the Start/End button to toggle to End.
6. Repeat steps 2 and 3 to indicate the ending balance and volume.
7. Click Preview to run the current animation while playing the new sound effect.    The sound
effect wont be permanently applied to the animation until you click Record.
8. Click Record to permanently apply the new settings to the sound sample, or Cancel to 
abort the Volume F/X.
When you enter the Volume F/X dialogue box, the sliders are already set to the volume and 
balance of the active frame. 
Volume F/X are attached to the frame, not the sound. As the animation passes each frame, 
the volume and balance change to the values in that frame. If you replace a sound, the new 
sound uses the existing Volume F/X settings. 

Loop f/x
This feature lets you repeat portions of your animation during playback. For example, you 
can specify that a certain sequence in the middle of your animation should be repeated 
three times, and then the rest of the animation should continue straight on from the end of 
the third repetition. Loop F/X lets you save disk space, create longer animations, and 
enhance playback speed.    
You can Loop to any frame, forward or backward. And you can loop into the middle of other 
loops    in fact, you can nest up to 32 levels of loops-within-loops.

The dialogue box includes:
Loop to Frame      The number in this box indicates the frame in which the looping effect 
should begin. For example, if you want to loop from frame 50 back to frame 1, move to 
frame 50 in the main workspace screen, and enter frame 1 here.
If the active frame already has a    loop effect defined, the frame slider in the Frame Bar will 
be red instead of blue. Defining a new loop effect for a frame which already has one erases 
the previous effect. If either the Start frame or the Target frame is deleted, the associated 
loop effect is also deleted.
Loop Type    This option offers you two types of playback:
 Loop    Plays the selected segment over and over from the beginning. In the above example,
it would play frames 1 through 50, and then loop back to frame 1.



 Ping Pong      Plays the selected segment    forward, then backwards, then forward again.    In 
the above example, it would play backward from 50 to 1, then forward to 50, and then 
backward again.
Loop Termination    These options tell PC Animate how the loop should end.    The options 
include:
 Enter Key    Sets up an infinite loop that ends only when any keyboard key is pressed
 Left Mouse Button      Sets up an infinite loop that ends only when the left mouse button is 
pressed
 Count    The loop will repeat the number of times you indicate in this box.
 Other      Lets you trigger the end of the loop with some kind of external event, such as a 
specific joystick movement or other device input. For example, if    you were running your 
animation over a CD-ROM or laser disc image, you could have the loop end when a certain 
point in the video image was reached.    The software that includes this feature is part of the 
Presidio Developers Disk. Contact Presidio for more information.
OK    Permanently applies the indicated loop effects to the current animation.
Cancel    Leaves the Loop F/X dialogue box without altering the current animation.
Delete    Removes any loop F/X commands from the current frame.

Trigger Event
This option lets you control an external device, such as a CD-ROM drive, laser disc, or VCR 
from your animation.    This feature requires the Presidio Developers Disk. To get this disk, 
contact Presidio at the address listed in the Welcome section of this manual.

Blue Pic, Next Blue, and Undo Blue are blueline effects that are useful for aligning elements 
in cel animation.

Blue Pic
Blue Pic traces a blue outline around all new artwork youve added since entering the current
frame.    (Artwork that was already in the frame is not affected.) This outline is a computer 
version of the non-reproducible light blue pencil used by drafts people and artists to sketch 
temporary guidelines into their work    lines that are not intended to appear in the final 
image. 
When artwork is bluelined, the line appears in Color 1, the second color from the left in the 
color bars. Color 1 is dark blue in the default palette. This color can be changed to make it 
easier to see or to use in another part of the drawing. The Blue artwork will appear in the 
new color, but its function doesnt change.
To use Blue Pic:
1. Create new artwork in the main workspace.    The space can be blank, or have existing 
artwork already in it.    You can use any tool or color to create this artwork, or paste in an 
image from the Clip Buffer.    You cannot, however, load an overlay or underlay.
2. Select Blue Pic from the Frames menu.    The new artwork will appear in blue, and the 
program will automatically move you into the next frame. The blued outline will appear in 
the same place on that frame.    
3. Use the drawing tools to trace over the blued outline and make the subtle changes 
needed to continue the illusion of movement.
4. When you are finished with the blue artwork, select Unblue Pic from the Frames menu. 
The blue artwork is restored to its original color and position in the first frame.

Next Blue
Next Blue makes it easy to accurately position an animated element across a range of 
frames. To use Next Blue:
1. Set up a range of    frames to be animated. This can be a new animation, or an addition to 
an existing one.
2. Go to the first frame and draw the animated object in its starting position. 
3. Select Next Blue. This automatically shifts you into the second frame, and displays a 



blued image of the object you drew in its starting position. Draw the object in its second 
frame position using the blued image as a reference. 
4. Select Next Blue again. You are now in the third frame with a blued image of the object in 
its second frame position. Draw the object in its third frame position. 
5. Continue the above process until the animation is completed.
Use Unblue Pic or Next Blue to remove the Blue artwork. 

Unblue Pic
Unblue Pic removes the blue outlines created by Blue Pic and Next Blue in the current frame.

Clip Changes
Clip Changes captures any new artwork youve added to the current frame, and pastes it in 
the Clip Buffer. 

Next Changes
Next Changes captures the new artwork youve added to the current frame,    and pastes 
them to the next frame. At the same time, it    automatically moves you into the next frame 
(which now becomes the new current frame.) The new artwork is pasted according to the 
Over/Under and Use All/No Keys/No Picture settings in the Frame Bar. 

Delete 
Delete erases the selected frames and removes them from the animation.



The Clip Menu
The Clip Menu contains the tools you use to manipulate objects in the clip buffer.

Cut
The Cut tool lets you capture a piece of the workspace screen a    put it in the clip buffer. 
When you select Cut from the menu, a crosshair appears onscreen.    Heres how it works:

1.    Position the crosshair at the edge of the picture element you want to capture.
2.    Hold down the left mouse button, and drag the crosshair across the image. As you drag 
the mouse, a bounding box appears onscreen around the image.
3. Release the mouse button when everything you want to clip is contained inside the box. 
When you let go, the contents of the box are automatically copied to the clip buffer, and you
will be returned to the Draw screen with the current drawing tool.
During a cut, the cursors X/Y coordinates are displayed in the upper-left corner of the screen.
The numbers represent pixels starting with 0,0 in the upper-left.
You cant undo Cut. To correct mistakes, simply repeat the Cut process again. Your new 
selection will overwrite the previous one in the clip buffer.

Clip
Clip automatically captures the entire main workspace screen, and copies it into the clip 
buffer.

Paste 
Paste lets you copy the contents of the clip buffer into the current frame, or into the range of
frames currently specified by the F/S/A command in the Frame Bar.
When you select Paste, the contents of the clip buffer appear inside a bounding box on the 
main screen.    
 Use the left mouse button to drag the box around the screen to position the clip.    If you 
change your mind and want to abort the clip, press Esc.
    When youve got the clip where you want it, click the right mouse button to permanently 
paste    it into that position.    Be careful    once you right-click, the paste cannot be undone!
The clip is copied onto the affected frames according to the F/S/A,    Tween Over/Under, and 
Use All/No Keys/No Picture settings in the Frame Bar. In Segment and All modes, a warning 
box is displayed before the clip is rendered into the range of frames, so you can change your
mind.
Heres how the F/S/A and Tween settings work together to copy the clip quickly across 
several frames:
 Frame The clip is copied into the current frame in its final position. Tween has no effect.
 Segment/Tween On The clip is copied into all the frames in the selected segment. Tween will
incrementally shift the clip along the specified motion path, so it appears in its final position 
in the last frame of the segment. 
 Segment/Tween Off The clip is copied into each frame in the selected segment. In every 
frame, it appears in the same position.
 All/Tween On    The clip is copied into every frame of the    entire animation. Tween 
incrementally shifts the clip along the specified motion path, from its starting position in the 
first frame to its final position in the last frame.
 All/Tween Off    The clip is copied into each frame in the animation in its final position.
You can interrupt multi-frame paste operations in Segment or All by pressing Esc or right-
clicking.

Move
Move lets you move art elements around the screen. These elements can include a portion 
of your existing frame, or a clip imported from another frame via the clip buffer.    To use 
Move:
1.    Select Cut from the Clip menu, and use the crosshairs to capture the art element you 



want to move. When you release the left mouse button, the contents of the bounding box 
are automatically copied to the clip buffer.
2. Select Move from the Clip menu. The item you just cut reappears onscreen, still in its 
bounding box.
3. Use the mouse to drag the clip around the screen until its where you want it. Right-click to
set the new location. Dont panic: the clip disappears from the screen temporarily, but it will 
be back!
4. Right-click again to return to the menu screen, and select Paste from the Clip menu. 
Right-click one more time. This permanently pastes the clip into it s new location, and it 
reappears on the main workspace screen.    If you change your mind, select Undo from the 
Draw menu immediately.

Rotate
Rotate turns and moves the contents of the clip buffer, and copies the resulting altered 
image into the selected frames.    To use Rotate:
1. Select Rotate from the Clip menu. The image in the clip buffer appears on the workspace 
screen in a bounding box. 
2. Go to the Rotation Axis dialogue box that appears, and click X, Y, or Z to indicate which 
axis you want the clip image to rotate on. The X/Y coordinates of the images center point 
and the number of degrees the clip has been rotated from its original position also appear in 
this box.
3. Hold down the left mouse button somewhere just outside the bounding box.    A clock-like 
hand connects the cursor arrow and the center of the image. Drag this hand in a circle 
around the outside of the box to rotate the image along the selected axis. Click the left 
mouse button once to restore the image to its original position, or press Esc to quit the 
Rotate operation.
4. To permanently place the rotated image in its new position, right-click to return to the 
menu screen, and select Paste from the Clip menu.
You can use Rotate with the F/S/A settings in the Frame Bar to copy the image to a range of 
frames, and Tween to incrementally rotate the image between each frame.

Stretch
Stretch lets you change the horizontal and vertical dimensions of an onscreen art element.    
To use Stretch:
1. Select Cut from the Clip menu, and place a bounding box around the image you want to 
stretch.    When you release the left mouse button, the contents of the bounding box are 
automatically copied to the clip buffer.
2. Select Stretch from the Clip menu. The item you just cut reappears onscreen, still in its 
bounding box.
3. Use the cursor arrow to grab one of the four sides of the bounding box.    As you drag the 
edge up, down, or to the right or left, the image in the box changes to meet the new shape 
of the box.    
4. If you want to reposition the entire clip,    put the cursor arrow inside the box and drag it to
its new location. 
5. Right-click to permanently set the clips new dimensions, or paste it into its new location.    
If you change your mind, select Undo from the Draw menu immediately.
The upper-left corner of the screen displays the X/Y pixel coordinates for the location of the 
box. Following the coordinates are percentages indicating how much horizontal and vertical 
stretching has occurred.    (The original    image is at 100%, 100%.)
The Clip is copied onto the affected frames according to the Over/Under and Use All/No 
Keys/No Picture settings in the Clip menu. In Segment and All this cannot be undone; a 
warning box is displayed so you can change your mind.
You can interrupt multi-frame Stretch operations by pressing Esc or right-clicking.

Invert



This command displays the contents of the clip buffer in an onscreen bounding box, and lets 
you flip or invert the image.
Theres nothing tricky about using Invert: just click once on the    outside edge of the 
bounding box to turn the image 180    degrees in that direction. For example, click just below
the box to turn the image upside down; click    just above the box to restore it upright. Click 
outside the left or right edges to flip the image horizontally. 
Use the left    mouse button to drag the bounding box to another location on the screen. Click
the right mouse button to permanently place the inverted or flipped image in its new 
location.
The upper-left corner of the screen displays the X/Y coordinates for the center point of the 
box. 
You can use the F/S/A, Tween, Over/Under, and Use All/No Keys/No Picture settings in the 
Frame Bar to apply an invert effect across a sequence of frames. In Segment and All this 
cannot be undone; a warning box is displayed so you can change your mind. 
You can interrupt    multi-frame Invert operations by pressing Esc or right-clicking.

Fit Colors 
When the palette of the incoming clip is different from the one youre using in the main 
workspace,    you can use Fit Colors to automatically adjust the clip palette to more closely 
resemble the one in the workspace.
For example, imagine youve got a clip with blue sky drawn in Color 2 and green grass drawn 
in Color 3.    However, the workspace palette has red in Color 2, orange in Color 3, green in 
Color 4, and blue in Color 5. If you paste the clip into that frame without fitting the colors, 
the sky will be red and the grass will be orange.
Fit Colors finds the closest shade of blue in the main workspace palette (in this case, the 
blue in Color 5), and re-maps the Clips sky to it. It finds the closest shade of green, (Color 
4 ), and re-maps the grass to it. Now, when you paste the clip into the current frame, the sky
is blue and the grass is green.

One Color 
One Color changes all the colors in the Clip (except the Key Color) to the currently selected 
color in the main workspace palette. Simply select One Color, and the clip is immediately 
redrawn in the current color. 

Negative
Negative can be used with Over and No Picture to create matte outlines of an image.    This 
matte can then be used as a    mask or a positioning element as you create other artwork.    
Negative changes all the colors in the clip (except the Key Color) to the Key Color, and 
changes the Key Color to the current color. To use it, just click on Negative, and the clip is 
immediately redrawn in the new colors. 

Over/Under
This command gives you menu access to the Over/Under feature, which is also available 
through the Frame Bar. For a complete explanation, see Over/Under in the Frame Bar.

Use All/No Keys/No Picture
This command gives you menu access to the Use All/No Keys/No Picture feature, which is 
also available through the Frame Bar. For a complete explanation, see All/No Keys/No Picture 
in the Frame Bar.

Tween On/Off
This command gives you menu access to the Tween feature, which is also available through 
the Frame Bar. For a complete explanation, see Tween in the Frame Bar.



The Draw Menu
The Draw menu contains all the drawing tools you need to create your artwork.    The Draw 
commands include all your line and shape tools.    However, you wont find your brushes or 
colors here    they can be found on their own main menus.
There are two characteristics that are common to all the tools on this menu:
    The current drawing tool is automatically deselected when you select another one. This 
makes it very easy to switch from one tool to another.
 If you decide you dont like the last line or shape you drew, select the Undo command (also 
found on this menu) to erase it.

Draw
Draw is the onscreen version of a paintbrush or pencil.    Select this tool to draw freehand 
lines with the currently selected brush and color. (To find out more about    brushes, please 
turn to The Brush Menu.    For information about using colors, turn to The Color Menu.)
Once youve chosen the Draw tool, right-click to go to the main screen. Hold down the left 
mouse button and move the mouse to draw a line. The speed of your movements can 
dramatically affect the kind of line you get: if you move the mouse quickly,    a curved line 
may appear as a series of connect-the-dot type straight-line segments. 

Line
Line creates straight lines using the current brush and the current color. 
The Line command behaves differently depending on the setting of the Distinct, Joined, and 
Concentric commands in the Modes menu:
 Distinct    To draw a single, distinct line, place the cursor at the lines starting point. Drag the 
mouse to stretch out a straight line extending from that point. Release the mouse to end the
line. 
 Joined    A series of straight lines connected head to tail, like connect-the-dots segments. 
Draw the first line as you would a distinct line. Next, click to begin a second line segment 
extending from the end of the first.    Release the mouse to end the second line. Keep 
clicking, dragging, and releasing to add more line segments, or right-click to end the series 
of joined lines.
 Concentric    Concentric lines radiate out from a common starting point, like clock hands. 
Draw the first line as usual.    Then, click and drag out a second line extending from the same
starting point as the first. Keep clicking, dragging, and releasing to add more concentric 
lines. Right-click to end the series of concentric lines.

Box
Choose Box to draw squares and rectangles using the current brush and color. Box does 
different things, depending on the settings of the Distinct, Joined, Concentric, and Hollow 
commands in the Modes menu:
 Distinct    To draw separate, distinct boxes, click the mouse to anchor the first corner of the 
box. Drag to stretch    the box out to the desired size and shape. Release the mouse button 
to set the final corner of the box.
 Joined      Joined boxes are a series of boxes in which the first corner of the new one is 
connected to the last corner of the previous one.    To create joined boxes, draw the first box 
the same way youd draw a distinct box, above. Now, click and drag out a second box from 
the ending corner of the first one. Keep clicking, dragging, and releasing to add boxes to the 
series. Right-click to end the sequence of joined boxes.
 Concentric    Concentric boxes are a series of boxes all centered around a single point. The 
final effect is similar to a nested group of picture frames.    To create concentric boxes, simple
draw the first box and release. Then, draw the second box and release.    All the boxes you 
draw will be centered on the same point until to click on the right mouse button to end the 
sequence. 
 Hollow    When Hollow is selected, the boxes appear as hollow outline shapes. When Hollow 
is turned off, the boxes are filled with    the current color.



Polygon
Polygon draws filled or unfilled multi-sized shapes using the current brush and the current 
color. 
To use Polygon, select the tool and right-click to return to the workspace screen. Click to 
anchor the first corner of the polygon. Click again to anchor each subsequent corner.    The 
polygon will stretch out like a rubber band. When all the corners are positioned correctly, 
right-click to complete the polygon.

When Hollow is selected the polygon appears as an outline in the current color. When Hollow
is not selected, the polygon is completely filled in with the current color.

Circle
The Circle tool creates circles and ovals using the current brush and the current color. Circle 
behaves differently depending on the setting of the Distinct, Joined, Concentric, and Hollow 
commands in the Modes menu.
If you hold down the Ctrl key as you draw your circles,    to get perfect circles, hold down Ctrl 
and Shift. Also draw, box,
 Distinct    Draws separate, distinct circles each time you click and drag the mouse. Select 
the Circle tool from the menu, and return to the Draw screen. Click to anchor the center of 
the circle. Keep the mouse button down, and drag the mouse to stretch the circle out to the 
desired size and shape. Release the mouse button to finish the circle.
 Joined    Joined circles are a series of shapes that overlap. The second circle is centered on 
the rim of the first one, at the same point    where the mouse button was released when 
drawing the first. 
To create a set of    joined circles, draw the first circle. Click and drag the mouse to draw 
another circle centered on the circumference of the first.    Keep clicking, dragging, and 
releasing to draw additional joined circles. Right-click to end the sequence of joined circles.
 Concentric    Draws circles that are all centered on one point. Draw the first circle. When you
draw the second, third, and fourth circles, they will be centered on the same point as the 
first circle. Right-click to end the series of concentric circles.
 Hollow    When Hollow is selected the circles are drawn as outlined shapes. When Hollow is 
not selected the circles are filled solidly with the current    color.

Fill
Fill is a drawing tool that floods any bounded area with the current color.    Select the Fill tool,
then right-click to return to the draw screen. Click anywhere in the area you want to fill. It 
fills immediately.
Fill only spreads through pixels that are adjacent horizontally or vertically. It does not spread 
through pixels that are adjacent diagonally.    If any areas are skipped because of this effect, 
simply click again in the bypassed area to fill it.

Streak
Streak is a drawing tool that draws dotted freeform lines using the current brush and color. 
Select the Streak tool, and return to the workspace screen. Drag the mouse to draw a    
streaked, intermittent line. 
The streaks are set down in a uniform time period, so if you draw slowly, the dots will be 
close together. If you sketch quickly, the dots will be farther apart.

Airbrush
Airbrush is the computer version of a can of spray paint.    It sprays a    random pattern of 
pixels in the current color.    You can control the type of spray you get using the two slider 
bars in the Airbrush dialogue box in the Mode Menu
 Speed    Move the slider to change the rate at which the paint is applied.    A slow speed 
gives you a light smattering of pixels; a high speed can quickly paint over a significant area 



of the screen.
 Size    The pixels of color are applied randomly within a defined circle.    The Size slider lets 
you focus the spray into a small circle, or diffuse it over a larger area. In either case, this 
circled area is centered around your cursor onscreen. 

Spline
Spline works much line the Line tool in the Joined mode, except that you can stretch the line 
segments into smooth arcs. Its a more precise way to draft a line. 
To use Spline, select the tool and right-click to return to the main workspace.    Draw a series 
of line segments (see the description of Joined Lines, above, to find out how to do this). 
Right-click to end the joined line sequence. Next, use the cursor to grab and drag the middle
of one of the line segments. As you pull the cursor to one side, the line will bend with it like a
rubber band. When you release the mouse button, the new arc will stay put.

Text
Text lets you put typed text characters into your animation.      These text blocks can be 
applied to animated forms, or actually become animations themselves. To use Text:
1. The Windows system font is the only font that is always loaded and available. Any other 
fonts must be loaded into PC Animate for Windows before you can use them in a text block.   
Select Fonts from the Modes Menu to choose the font you want to use.
2. Select Text from the Draw menu, and right-click to return to the workspace screen.    Start 
typing in your text.    (Dont worry about the positioning: that comes later.)    The letters will 
appear at the point of your cursor arrow.    Use the Backspace key to delete mistakes and 
unwanted text.
3. Once youve typed your text block, move the cursor arrow to position it    where you want it
onscreen.    The text will stay attached to the tip of the cursor arrow until you click the left 
button to place it. 
If you change your mind, choose Undo from the Draw menu to remove the text, or right-click
again to delete the text and return to the menu screen.
The PC Animate for Windows keyboard alternatives are not available while in the workspace 
screen with the Text tool.    To leave the Text tool, use the mouse to select another tool from 
the Draw menu.

Pixel f/x
Pixel F/X displays the Pixel F/Xdialogue box, which gives you access to 12 special graphics 
effects.    All these effects are possible simply by modifying the pixels that make up the 
image.
All    12 pixel effects can be applied to a range of    frames using the F/S/A setting on the 
Frame Bar. To interrupt a multi-frame operation in Segment or All , press Esc or right-click.
The Tween setting on the Frame Bar works well with the    Shatter, Crystalize, Unrez, Wipe, 
Venetian, Ripple and Buzz effects described below.    In these effects, Tween incrementally 
implements the effect across the selected range of frames. 
Defocus, Antialias, Outline, Edge In, and Tile are not affected by Tween.
Just click one of the buttons in the Pixel F/X dialogue box    to select one of the 12 effects:

 Defocus blurs the selected onscreen images for an out-of-focus effect. Click Defocus again 
to increase the amount of blurring. 

 Antialias smooths the images in the affected frames. This helps eliminate the stairstep 
jaggies common to computer pictures, and creates more natural-looking edges. It can be 
repeated for additional smoothing. 

 Outline    turns all the solidly color-filled areas of the screen into hollowed-out outline figures.
The outlines for each area appear in the same color that originally filled the area.



 Edge In borders each colored area of the picture with an outline of the current color.    This is
useful if you want a tracing of the picture to use in cel animation.

 Shatter shifts alternate scan lines horizontally in so that the image appears to dissolve into 
fine horizontal lines, which then pull apart toward the edges of the screen. As the image 
disappears, the blank screen is filled with the current color.    Shatter is very effective as a 
transition from one act of your production into another. 

 Crystalize calculates a new color for each pixel based on the colors of the four adjacent 
pixels. The net effect is that all the colors in the image are randomized over time, causing 
the image to dissolve into random pixels.
Click on Crystalize to immediately begin the process. In Segment and All    modes, Crystalize 
cannot be undone or restored. A warning box appears so you can change your mind. 
With the F/S/A settings and Tween, you can get    a variety of effects:
Frame    The current frame is crystalized. Tween has no effect.
Segment or All/Tween Off    Each frame in the active segment is crystalized.
Segment or All/Tween On The first frame in the active segment is crystalized, copied to the 
next frame, crystalized again, copied to the next frame, crystalized again, and so on through
the segment. The original contents of the frames are erased, leaving only the increasingly 
crystalized versions of the first frame.

 Tile duplicates a selected clip in a tile-like grid pattern that fills the entire screen. To use 
Tile:
1.    Select Tile and right-click to return to the workspace screen.    Draw a bounding box 
around the piece of the screen you want to use as your tile    If you want to import a clip from
the clip buffer to use as your tile, select Paste and put it in the workspace before selecting 
Tile.
2. The contents of the bounding box are automatically tiled across the screen.    Each tile will 
be the same size as the original bounding box. The entire grid is centered around the 
location of the original rectangle.    Partial tiles extend off-screen, if necessary. 
In Segment and All, Tile cannot be undone or restored. A warning box is displayed so you 
can change your mind. Tile is unaffected by Tween.

 Unrez    is the inverse of Antialias: it simulates a lower resolution picture by taking a smooth-
edged image and putting in those stairstep jaggies that make pictures look computer-
generated.    Click Unrez repeatedly to keep reducing the resolution.    
Unrez works well with Tween On in Segment and All modes.

 Wipe sweeps across the screen, replacing the picture with the current color.    The effect is 
as though    someone closed a sliding window on the    current image.    Like Shatter, its a 
good transition between scenes or acts in your production.    
Select Wipe to see the Direction dialogue box. Here, you can indicate whether your wipe 
should go Up (from bottom to top), Down (top to bottom), Left (from right to left), or Right 
(from left to right).    
You can also combine vertical and horizontal direction settings to get diagonal wipes. For 
example, choose Up and Right to create a wipe that moves from lower left to    upper right.    
If you combine Up and Down, Left and Right, or all four at once, the effect is a wipe that fills 
only half the screen.    This is useful if you want to use half the screen for graphics, and the 
other half for, say, a solid color block that moves in and out with titles on it.      
Wipes work well with Segment /All and Tween.      Using Wipe with the F/S/A toggle set to 
Frame to will give you the half-screen wipe described above.

 Venetian splits the screen into eight bands and sweeps across the bands replacing the 
picture with the current color. The effect is like closing venetian blinds.
The sweep can be from top to bottom, bottom to top, left to right, or right to left.



Select Venetian to display the Direction dialogue box. Click Up (sweep from bottom to top), 
Down (top to bottom), Left    (right to left), or    Right (left to right). Venetian can be repeated 
in other directions to make combination sweeps.

 Ripple makes the entire screen break into vertical waves, which them wiggle back and forth.
When Ripple causes blank areas to form on the screen, they are filled with the current color.
Selecting Ripple automatically returns you to the workspace screen.    There, use the mouse 
to drag out a box which defines the size of one sine wave. Release the mouse button to 
apply the wave youve defined to the entire screen, and begin the Ripple process. Portions of 
the rippled image may extend off-screen. Ripple works well with Segment/All and Tween.    
Note that    in Segment and All, it cant be undone or restored (a warning box is displayed so 
you can change your mind). 

 Buzz    works exactly like Ripple, except the vertical waves are sharpened into sawtooth, zig-
zag type edges. Follow the directions for Ripple, immediately above.

Undo
Undo reverses the last change you made to the current frame.    
Once you make an additional change to a frame, leave the frame, or do a multi-frame 
change with Segment or All, you can no longer undo the previous change.    
Undo can be reversed: if you selected Undo to erase a change, you can still choose Undo 
again to restore it. 

Restore
Restore erases all the changes made to the current frame since you entered it. Restore can 
be reversed with Undo    though this must be done before any additional changes are made. 
Once you leave a frame or do a multi-frame change, the contents of the frame can no longer
be restored.

Clear Pic
Clear Pic erases the contents of the selected frames. 
WARNING: In Segment and All modes, Clear Pic cannot be undone or restored. A warning box
is displayed so you can change your mind. 



The Modes Menu
The Modes menu contains some of the basic tools you can use anywhere on the PC Animate 
workscreen including important things like your fonts and the Zoom tool.

Zoom
Zoom magnifies a portion of the current frame, enabling you to see and work with it in 
greater detail.    Its especially useful for drawing intricate objects pixel-by-pixel.
Selecting Zoom puts a fixed-size bounding box on the workspace screen.    Use the mouse to 
place the box around the area you want to zoom in on. Click the left button to blow up the 
contents of the box.    You can now work within the magnified area.    
Some things to remember when working in Zoom:
 The active drawing tool is always the single-pixel paintbrush. 
 To move the Zoom box to another area of the screen, use the slider bars that appear to the 
right of and underneath the workspace.
 Most of the normal keyboard command options are not available in Zoom.    The only two 
that apply are:
- left arrow return to previous frame
- right arrow go forward to next frame
Select Zoom again to return to the unmagnified view.

Hollow
When you select Hollow, the shapes you create with the Box, Polygon, and Circle tools 
appear as hollow outlines of the current color. When Hollow is turned off, new shapes are 
filled in with the current color as you draw them.

Distinct/Joined/Concentric
The Distinct, Joined, and Concentric modes offer you three different ways to use the Line, 
Box, and Circle tools.    In general:
    Distinct    Creates separate, distinct lines, boxes, or circles
    Joined    Creates shapes with the endpoint of one attached to the starting point of the next. 
    Concentric    Creates shapes which have the same center point. 
For more specific descriptions of how these commands work with specific drawing tools, 
please refer to the Line, Box, and Circle tool descriptions under the Draw Menu. 

Airspeed
Airspeed sets the speed and nozzle size for the Airbrush drawing tool. 
Select Airspeed to display the Airbrush Adjustments dialogue box. The Speed slider sets the 
rate at which color is applied to the screen. A low speed means the color will be applied in 
light spatters; a higher speed makes the paint spray very fast.      The speeds range from 1 
(low) to 100 (high).    To change the number, use the slider bar or click on the number box 
and type the value you want.
The Spread slider sets the size of the airbrushs circular nozzle. Smaller numbers make 
smaller, very focused circles; larger numbers make larger, more diffused circles.    This slider 
also ranges from 1 to 100.    To change the number, use the slider bar, or click on the number
box and type the value you want.

Fonts
Fonts displays the Fonts dialogue box.    This box lets you choose from your collection of 
Windows fonts, and change the size and type style of the fonts youve chosen.    Once youve 
selected a font, use the Text tool from the Draw menu to create text blocks and place them 
in your frames. To specify a font:
1. Select a font from the directory at left. Use the slider bar to view the entire list. 
2. Select the type style from the Font Style directory in the center.
3. Select the type size from the Size directory at right. 
4. Click OK to confirm your selection and move back to the workspace, or Cancel to leave 



the dialogue box without implementing the font.
5. Select the text tool from the draw menu. Right-click to enter the workspace screen.
6. Type your text.    You can use the cursor to move the text block around the screen. When 
its where you want it, left click to paste it in place.



The Brush Menu
From the Brush Menu, you have access to PC Animate for Windows full range of drawing 
tools.    The program includes 16 built-in brush tools, and options that let you turn almost any
onscreen art element into a custom brush.    These custom brushes can be temporary (see 
Get Brush) or saved to a BMP file for later use (see Select Brush).    They can be just one 
color (see Get Brush), or many colors (see Take Brush).    And its all done with just    three 
commands:

Select Brush
Choose Select Brush    to view the Select Brush dialogue box, which lets you choose from PC 
Animate for Windows built-in collection of drawing tools, or create and save a custom brush. 
Unlike most dialogue boxes, the Select Brush dialogue box stays onscreen until you click in 
the upper left corner to put it away.    This keeps your drawing tools handy onscreen while 
you work. You can drag the window around the screen to where its most convenient.

Using Built-in Brushes 
Click Select Brush to display the Select Brush dialogue box. This dialogue box displays the 
16 built-in brushes. The current brush is highlighted with a shadowed border and a red 
center.    To choose one of these brushes, just click on it, then right-click to return to your 
workspace and start using it. 

Using Custom Brushes 
Creating Custom Brushes    You can save any art element onscreen as a brush, and then use 
it with any of the drawing tools on the Draw menu. For example, you might save a hand-
drawn daisy as a brush, and then use it with the Airbrush to create an entire meadow of 
scattered flowers. Basically, you can load any    .BMP file as a brush. 
To create a    custom brush:
1. Choose Select Brush from the Modes menu, and click the square on the Custom Brushes 
toolkit that you want the new brush to occupy. 
2.    Select Get Brush from the Modes menu, and place the    onscreen bounding box around 
the object that you want to save as a brush.    Left-click to select the square.
3. Your new brush appears in the indicated square in the Custom Brush toolkit, ready to use. 
Saving Custom Brushes    The above instructions create a temporary custom brush    that is, 
the brush is deleted when you quit the animation file.    If you want to save the brush for 
retrieval in your next work session, you can save it as a .BMP file:
1. Go to the Custom Brush toolkit and click the brush you want    to save.
2. Click the Save button at the bottom of the Select Brush    dialogue box. 
3. In the Save dialogue box that appears, give your brush a file name, and indicate where 
you want to store it. Click OK.
Loading Custom Brushes    To reload a previously saved custom brush: 
1. Choose Select Brush from the Modes menu, and click on the toolkit square that you want 
the incoming brush to occupy.
2. Click the Load button at the bottom of the dialogue box. From the new dialogue box that 
appears, select the .BMP file containing the brush you want to load. Click OK. The brush soon
appears in the square you selected, ready for use. 
Get Brush lets you grab a small piece of your onscreen artwork to use as a    one-color brush:
1.      Choose Select Brush from the Modes menu, and click the square on the Custom 
Brushes toolkit that you want the new brush to occupy. 
2.    Select Get Brush from the Modes menu, and place the    onscreen bounding box around 
the object that you want to save as a brush.    Left-click to select the square.
3. Your new brush appears in the indicated square in the Custom Brush toolkit, ready to use.

Get Brush
Get Brush can only handle single-color brushes. If the image you selected for you custom 
brush was originally multi-colored, the new brush will be set to the color tha's currently 



selected in the palette. To change this color, select a new color from the palette.    To create 
and use multi-colored brushes, see the Take Clip feature (described just below).
You can also save your new brush using the Save feature from the Select Brush custom 
menu. This procedure is described in Saving Custom Brushes under Select Brush, above.    If 
you dont save it, the brush will be eliminated when you close the current animation file. 

Take Clip
Take Clip works with the Clip Buffer to let you create multi-color custom brushes.    To use 
Take Clip:
1. Select the Cut    command from the File menu. Use the onscreen crosshairs to drag a 
bounding box around the image you want to use as a brush. When you release the mouse 
button, the piece is automatically sent to the clip buffer.    
2. Now, select Take Clip from the Modes Menu. A bounding box appears onscreen with your 
clip in it. That box is your new brush. The brush will remain available onscreen until you 
select a different tool from the Draw or Brush menus. 
Saving Multi-Color Brushes    While you cant save the contents of the clip buffer, you can 
save the entire frame that contains your brush, and later retrieve your brush that way.    To 
save the entire frame as a .GIF file:
1. Make sure the F/S/A setting on the Frame Bar is set to F (Frame). 
2. Select Save from the File menu.    Name the file, indicate the directory you want to store it 
in, and click OK to start the save.
3. To re-load the image, select Load from the File menu.    When the frame containing your 
brush reappears, use the Cut and Take Clip commands to re-select the brush image.
Since Take Clip is a multi-color brush, Select Color and Cycle in the Color menu have no 
effect on the brush. The brush is applied according to the Over/Under and Use All/No 
Keys/No Picture settings in the Clip menu. If theres nothing the Clip Buffer, Take Clip will 
appear grayed on the menu, and will not be available to use.



The Color Menu
The Color Menu contains all the commands you need to work with the color palette (that is, 
the specific collection of colors used in each frame), so you can create and use these custom
colors in your artwork and animations. Generally, youll use one palette for the entire 
animation    but you also have the option of    creating a different    palette for each frame.
Depending on which hardware you own, PC Animate for Windows allows you to create a 
palette of 16 or 256 colors.

Select Color
Choose Select Color... to display the Select Color... palette box    the box which contains the 
color palette for the current frame.    This box is the central tool from which you create and 
select the colors you want for your artwork.    The
The box remains open onscreen until you click the small box in the upper left to put it away.   
You can position it in a convenient corner by grabbing the top bar and dragging the box to a 
new location.
Color Number 
In this manual and in the program, colors are sometimes referred to by a number indicating 
their location in the palette box.    These numbers are assigned from top left to lower right, 
and are counted across like words on a page. Therefore, Color 0 is the first color at the far 
left end of the top row; color 15 (or 255) is the last color on the right in the bottom row. The 
current color is highlighted with a red border.

Changing Colors
To change colors, just go to the palette and click on the new color you want. That will be 
your active color until you click on another one to select it. The active color will be applied 
according to the characteristics of the drawing tool youve chosen.
There is a special Select Color... function to use while in the Draw screen. Place the tip of the
mouse pointer over a pixel of the desired color (the color must already exist in the picture). 
Press C on the keyboard. The color register which contains that color becomes the current 
color register.

Defining Color Ranges
In the Select Color... box, you may notice a horizontal blue line    running under a group of 
boxes.    The line has a down arrow at one end, and an up arrow at the other.    Its there to let 
you define a range of colors to be used for color tweening, or in a palette effect, or for a 
variety of other uses (most of which are discussed later in this section). To use the range 
bar:
    Set the beginning of the range by holding down the    Control key as you click the color box
you want the range to start on.    The up arrow will    appear on that box.
    Set the end of the range    by holdingdown the Shift key and clicking onthe down arrow. 
The down arrow will appear onthe selected box.
The defined range doesnt necessarily have to run from top to bottom, or left to right.    For 
example, if you were defining a range for Color Cycling, you might set the down arrow on 
Color 220, toward the end of the palette, and place the up arrow    on Color 20 up near the 
beginning of the palette. The colors would then cycle from 220 back to 20, and repeat. 

Select Key
Select Key sets the key color for the current frame.    The key color is the one color that wont 
be affected by overlays, blue effects, and other operations.    Usually, the key color will be 
used as your background color. When you pick up, paste, or move an object onscreen, any 
part of the item thats colored in the key color wont be picked up inthe clip.
You can only have one key color in a frame at one time.

The Select Key dialogue box includes the entire palette for the current frame. The current 
key color is highlighted with a red border.    The default key color is black.



Like the Select Color....palette box, the Key Color palette box remains onscreen until you 
click in the upper left to put it away.

Gradient
The Gradient feature lets you select two colors    say, for example, a light blue and a dark 
blue    and then have the computer create a gradiated range of shades between the two 
colors youve selected.    This range can then be used as a fill in your drawing.    (In this 
example, the subtle range of blues might be used to create an interesting sky or water 
effect.) To create a gradient fill:
1. Select Gradient from the Color menu to view the Gradient dialogue box. The Select Color...
palette box will also appear automatically, if its not already onscreen.    The Gradient box 
contains a preview box on the left; a set of nine area boxes in the center; and a three option 
checkboxes on the right.
2. The nine small area boxes in the center of the Gradient dialogue box correspond to nine 
specific areas of the preview box.    Select a color from the Select Color... palette, then click 
in one of the area boxes to apply the color to that area of the preview box.    
NOTE:    The default color for the nine boxes is black.    The four corner boxes must    each 
contain a color before PC Animate for Windows can calculate the gradient.    The other five 
boxes can be disengaged (not factored into the gradient at all) if you simply right-click on 
them. To re-engage them, right click again.
To create a basic horizontal gradient, try putting color A in the upper left and right corner 
boxes, and color B in lower left and right corner boxes.    For a basic vertical gradient, try 
color A in the two left corners, and color B in the two right corners.
By using the nine boxes in combination, you can create horizontal,    vertical , diagonal, 
curved, moire, and a variety of other gradient effects.
3. The colors in the corner area boxes    define the starting and ending colors for your 
gradient.    The gradient between them will include all the colors that appear between them 
on the Select Color...palette box.      
For example,    imagine that you put red in the upper corner area boxes, and blue    in the 
bottom corners.    If    the palette include shades of purple between the red and the blue, 
those purples will be included in the final gradient.    If, on the other hand, the red and blue 
appear right next to each other on the palette, the gradient    will go straight from red into 
blue.
4. Once youve defined your gradient, you can use the Box, Polygon, Circle, and Fill tools to 
apply it to your drawing.      To use your gradient as the background for the entire screen, 
click Fill on the    screen background area.
Options
The Options check boxes give you extra control over the characteristics of your gradient.
 Scaled    Scales the entire gradient to fit into the image youve created.    For example, if you 
create a circle and fill it with the gradient,    the entire contents of the gradient preview box 
will be scaled to fit into the circle. If you resize the circle to make it bigger, the gradient will 
be rescaled so the colors in the circle will be proportionally scaled tothe new size.
 Unscaled    Unscaled treats the gradient as though it filled the entire screen behind the key 
color, and you are using your shape tool to open a window on it.    If you use the Box tool to 
draw a small box, for example, only part of the gradient image will show through the box-
shaped window youve opened. In the red/purple/blue example above, youd see shades of 
red in shapes made at the top of the screen, and shades of blue in windows opened at the 
bottom.
 Dither    Turn this on to create a soft, watercolor-like blend between the colors in the 
gradient.    Turn it off to get    solid, well-defined stripes of color.

Cycle Colors
Cycle Colors is a special effect that    automatically changes the color of the brush 
periodically as you draw.    To use Cycle Colors:
1. Make sure the palette is visible onscreen. If its not, choose Select Color... from the Color 



menu to display the palette.
2. Select Cycle Colors from the Color menu. This turns the feature on.    
3. Return to the palette, and define the range of colors you want to include in your color 
cycle.    To do this, place the down down arrow on the blue range selector bar on the starting 
color, and the up arrow on the ending color. 
4. Select a drawing or shape tool from the Draw menu, and start drawing. The colors will 
cycle as you draw, creating a multi-colored line. (For more about how different tools work 
with color cycling, see Color Cycling Effects below.)
5. To turn off Cycle Colors, select Cycle Colors again from the Color menu.

Color Cycling Effects
Each drawing tool has its own characteristic way of responding to Cycle Colors: 
    With the Draw and Streak tools,    moving the brush quickly gives you a shorter range of 
colors, and moving more slowly creates a line that includes more colors.    This is because 
the colors change at set periods of time.
    Airbrush randomly sprinkles the colors in the selected range for a confetti-like effect.
 When you use Fill, Polygon, Circle, and Box, the color cycles forward once with each new 
shape you draw.    For example, if you defined a range of seven colors to cycle, and drew 
seven circles, circle 1 would be in color 1, circle 2 in color 2, and so on. 
 If youre using the Line tool in    Distinct and Concentric modes, each new line uses the next 
color in the cycle range. In Joined mode, Line keeps the same color register for all connected
lines, and cycles for the next group of connected lines.
 When you use the Text tool, the color cycles forward once with each    new letter you type.

Palette 
The Palette command lets you mix a new color in any square of the palette box.    There are 
a couple of important things to remember when mixing new palette colors:
 Every frame in an animation has its own palette. The    Frame/Segment/All button in the 
Frame Bar allows to you assign a new color to the palette of the current frame,    or place it in
the same palette square in every palette in the range of frames youve selected.
 In 32K    True Color video mode, you cant use the palette to alter the colors in the video 
image. However, you can use the 32K image as a background for artwork generated by PCAs
drawing and text tools.

Creating New Colors
To change the color in one of the color squares on the palette: 
1.    Select Palette fromthe palette menu. This displays the Palette dialogue box, as well as 
the Select Color... palette box (if its not onscreen already). 
2. Move to the palette and click on the square containing the color you want to change. That
color also now appears in the larger square at the top of the Palette dialogue box.
3. Move to the three RGB value sliders. Every color in the rainbow is made up of some 
combination of red, green, and blue.      The R slider controls the amount of red in the color; 
the G slider controls the green; and the B slider controls the blue.    If you want    to mix a 
shade of blue-green,    set the R slider to 0, and the B to 100.    Then, add increasing amounts
of green until you get the color you want.
4. Now, set the HLS    sliders. 
H stands for Hue    the colors position on the rainbow spectrum.    
S stands for Saturation    the purity of the color. Low saturation means the color is more 
muted, and tends toward gray; high saturation gives you more of the true color.
L stands for Luminence    the relative brightness of the color onscreen. 
We encourage you to experiment with these sliders to see what effect each has on the final 
shade.
5. Click OK to apply the new color to the selected palette square.    If you have selected 
Segment or All from the F/S/A bar in the Frame Bar, the new color will appear in that 
numbered square in every palette in the indicated range. In Segment and All, palette 



changes cannot be undone or restored. A warning box appears so you can change your 
mind.

Manipulating Palette Colors
The buttons below the sliders in the Palette dialogue box let you cut, copy, and paste 
individual colors to other palettes in your animation.
 Cut copies the current    range of colors    (as defined by the range selector bar) into a 
temporary storage buffer.    
 Paste copies the colors from the temporary storage buffer into the current range of colors 
(as defined by the range selector bar). The colors will pasted into the color registers in the 
direction the arrow points. 
If there are more incoming colors in the buffer than there are in the range youve defined on 
the palette, the extra colors at the end of the incoming range will not be imported. If there 
are fewer colors in the buffer than there are in your defined palette range, the extra color 
squares will remain exactly as they are, with their original colors intact.
 Copy copies the color from the current color square into another square. Click    the color 
square you want to copy. Click Copy.    Then, click on the destination color square. The color 
will now appear in both squares.
 Restore undoes all the changes made to the palette since you entered the Palette dialogue 
box.
 UseClip replaces the current palette with the palette from the clip in the Clip Buffer. 
 Gradient    lets you create a range of colors quickly.    In short, you simply define the first and
last colors you want in your range, and Gradient automatically fills in the range colors that 
fall in between. 
For instance, to create a grayscale effect, use the range selector bar to define a sequence of
color squares.    Put white in the first box of the range, and black in the last.    When you click 
Gradient, the boxes in between are automatically filled with an evenly-spaced array of gray 
shades, from lightest to darkest. The first and last active colors are not changed.
Palette F/X displays the Palette Effects dialogue box, which helps you create automatic 
animated color effects.    This dialogue box allows you to create three categories of palette 
effects:    
 F/X      a grab bag of nine different effects you can achieve simply by tinkering with the 
colors within the current frame.
 Shift effects    effects created by changing the color of an onscreen object with each new 
frame, or over time
 Fade effects    effects that change the color of the entire screen with each new frame, or 
over time
To set up a palette effect:
1. Make sure the Select Color... palette for the current frame appears onscreen.    If its not 
visible, choose Select Color... from the Color menu to display the palette. 
2. Use the blue range selector arrows in the palette box to choose the range of colors you 
want the effect to be applied to.    
3. Click one of the three buttons in the second column from the left to select the type of 
effect youd like to create    a special effect, color shift, or fade. Specific descriptions of each 
type of effect follow below.
All of the palette effects decribed below can be used with the F/S/A settings in the Frame 
Bar. You can use these settings to apply your effect to a single frame, a segment of the 
animation, or the entire animation file. Palette effects in Segment and All cannot be undone, 
so we strongly recommend that you save your existing animation before using these 
functions.

Palette F/X
Click the F/X button on the Palette dialogue box or select Palette f/x from the color menu, to 
use the nine effects described below. These effects let you create a variety of unusual 
images, and are especially helpful for manipulating image colors to gain more information.



 Normal sets the palette to its original default colors. These are the colors in the palette 
when you first start PC Animate for Windows.
 Inverse reverses the RGB values of the colors in the affected range. The net effect looks like
a color negative, and useful for creating shadow effects and embossed images.
 Mono changes the colors in the selected range to shades of gray. You could use this to 
change a color image so that it appears in black and white.
The three effects described below render the image in three different black-and-white styles.
Theyre also useful if you want to group the spectrum of colors youre using by their 
luminance. For example, Xerox gives you two groups (light and dark); Metal gives you four 
groups; and Chrome breaks the colors into eight groups.
 Xerox changes the colors in the affected registers to either black or white. Colors with 
luminance settings of 0% to 50% of the maximum value are changed to black. Colors with 
luminance settings of 51% to 100% of the maximum value are changed to white. The net 
effect    looks like you put the image through a not-very-sensitive photocopy    machine.
 Metal is similar to Xerox, in that it changes the colors in the in the selected range to either 
black or white, but uses different ratios.    Color with a luminance of 0% to 25%    and 51% to 
75% of the maximum value are changed to black.    Colors with luminance settings or 26% to
50% and 76% to 100% are changed to white.    This creates the effect of a high-contrast 
black-and-white photo. 
 Chrome    works exactly like Metal, but offers a look thats more like the reflections off 
polished metal. Colors with luminance settings of 0% to 12%, 26% to 37%, 51% to 62%, and 
76% to 87% of the maximum value are changed to black. Colors with luminance settings of 
13% to 25%, 38% to 50%, 63% to 75%, and 88% to 100% of the maximum value are 
changed to white.The three effects below are useful when you want to filter out all but one 
of the three color values (red, green, or blue) that comprise the colors your selected range.    
If you apply one of these effects to the entire palette, the result is like looking at your image 
through red, green, or blue cellophane.
 Red sets the Green and Blue slider bars to 0 for all the colors in the selected range.
 Green set the Red and Blue slider bars to 0 for allthe colors in the selected range.
 Blue sets the Red and Green slider bars to 0 for al lthe colors in the selected range

Shift 
The Shift effects let you gradually change the a color (or a group of colors) over a series of 
frames, or over a set period of    time.    For example, you can select the range of sky shades 
in your palette, and have them gradually shift one shade to the right (as theyre ordered on 
the palette)    with each frame. If    your defined color range starts with sky blue and goes 
through    purple and navy, this gradual color shift    will create a slowly darkening evening 
sky as the series of frames is viewed.
The direction of the shift is determined by the direction of the color range selector arrow on 
the Select Color... palette.
You can set the shift to occur in two different ways:
 FPsh    (Frames per Shift)    This shifts the color by one color box with each new frame.    Start
by selecting the range of palette colors through which you want the shift to take place, and 
using the F/S/A slider on the Frame Bar to select the range of frames over which the effect 
will occur. 
Once youve set up the colors and frame range, click the FPSh button that appears to the 
right of the Palette F/X    box, and use the slider bar to set the number of frames that should 
run between each color shift.    Click Preview to see what youve wrought, and Render to 
permanently apply the finished effect to your animation file.
 ShOT (Shift Over Time)    This shifts the colors by several color boxes between each frame, 
for a    more rapid change. Start by selecting the range of palette colors through which you 
want the shift to take place, and using the F/S/A slider on the Frame Bar to select the range 
of frames over which the effect will occur. 
Once youve set up the colors and frame range, click the ShOT button that appears to the 
right of the Palette F/X    box. Use the slider bar to set the number of color boxes that should 



be skipped with each frame change. 
For example, setting ShOT to 4    would mean that, with every frame change, the program 
would shift four colors to the right in the selected palette range. Click Preview to see what 
youve wrought, and Render to permanently apply the finished effect to your animation file.

Fade    
Fade contains two effects that let you make subtle changes to the palette over time.
 Tint lets you select a color from your palette; define a range of colors; and have all the 
colors in the range gradually shift toward the selected color over a series of frames. For 
example, you could choose a    range of colors, and indicate that they should be tinted to 
100% black as the esegment plays.    At the end of the segment, all the colors in the range 
would appear to have gradually faded to black.
To use Tint:
1. Make sure the palette is visible onscreen. If its not, choose Select Color... from the Color 
menu to display it. Also, make sure that the Tween setting on the Frame Bar is on.    (Turning 
off Tween causes the entire tint to occur    between the first and second frames of the 
segments.)
2. Use the range selector bar on the palette to select the group of colors you want to tint.
3. Click on the color box of the color you want to tint the range to.
4. Click Fade on the Palette F/X menu. Next, click Tint.    Use the slider bar at right to indicate
the percentage of tint you want in the final frame of the sequence.
5. Click Preview to see what your new effect looks like. If its what you want, click Render to 
permanently apply the effect to your animation.
    Blend calculates a gradient between colors in the    palette of the first frame in a segment, 
and the last frame.    For example,    say you had a 20-frame segment animating a sunset.    In
Frame 1, Color 13 is a bright, sunny yellow.    In Frame 20 Color 13 is a deep, fiery red.    
When you select Blend, Color 13 incrementally changes from yellow to red over the course 
of the 20 frames    changing the color of your setting sun.
To use Blend:
1. Make sure the palette is visible onscreen. If its not, choose Select Color... from the Color 
menu to display it. 
2. Use the range selector bar on the palette to select the group of colors you want to blend. 
That same group will automatically be selected in the palettes for every frame in the 
segment.
3. Click Fade on the Palette F/X menu. Next, click Blend.    The slider bar at right lets you 
indicate the percentage of the final color you want to appear in the final frame of the 
sequence.    For example, using the sun example above, set the slider to 65% if you want the
yellow to blend 65% of the way to the red you selected.    Set the slider to 100% if you want 
to blend to the full shade of red.
4. Click Preview to see what it looks like. If its what you want, click Render to permanently 
apply the effect to your animation. Palette effects in Segment and All cannot be undone. A 
warning box is displayed so you can change your mind. 

Exchange Color 
Exchange Color is the easy    way to change all occurences of one color in your image to 
another palette color.    To make the change:
1. Make sure the palette is visible onscreen. If its not, choose Select Color... from the Color 
menu to display it.
2. Click the color you want to change to.    (For example, blue.)
3. Select Exchange Color from the Color menu.    This automatically puts you in the 
workspace screen.
4. Click on a pixel of the color you want to change. (For example, red.)    All instances of that 
red on the screen will instantly turn blue.
In Segment and All , Exchange Color cannot be undone or restored.    A warning box is 
displayed so you can change your mind. 



Exchange Range 
Exchange Range lets you change an entire range of colors to just one color. To make the 
change:
1. Make sure the palette is visible onscreen. If its not, choose Select Color... from the Color 
menu to display it.
2. Click the color you want to change to.    (For example, blue.)    Then, use the range selector
bar on the palette to choose all the colors you want to change to blue.
3. Select Exchange Range from the Color menu.    When you right-click to return to the 
workspace, all the colors in the range you defined will appear as blue.
In Segment and All , Exchange Color cannot be undone or restored.    A warning box is 
displayed so you can change your mind. 



The Help Menu

About
Select About... to find out the basic information about your version of PC Animate for 
Windows.    The About... window includes:
 Version number, author, and copyright information.
 Presidios address and phone number, for easy access in case you need to contact us.
 Current memory usage information.




